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The following sections describe new features and updates to existing features in Luminate Online Q1 2013. Please
share this information with other users in your organization.
Show Me:Watch videos about some of the features included in this release.

Advocacy
Changes to Advocacy in this release include, improved querying on Action Alerts and more frequent updates to
the Vote Center.

Query by Action Alert
To send an email to the constituents of the representatives targeted in an Action Alert, you create a query-based
group. Previously, the process of creating the query was very labor-intensive. The process is much faster with the
newAdd an Action Alert Clause button.

Note: The Add an Action Alert Clause feature is only available for Federal, State, and Custom targets. It is not
available for local, County and Municipal targets. It is also only available for Action Alerts; not for Call Alerts,
Vote Alerts, or Letter to the Editor Alerts.

The old query process:

1. Manually select 75members of Congress who they are targeting (that's 75 clicks).

2. Create a new query and click Add Group Clause.

3. Manually select each of the 75 congressional districts (for example, California District 1 ANDMaryland
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District 4 AND Texas District 8 and so on). It takes at least four clicks to add each district clause, meaning
you have to click 300 times to add 75 districts.

The new query process:

1. Manually select 75members of Congress who they are targeting (75 clicks).

2. Create a new query and click Add an Action Alert Clause.
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3. Select an Action Alert and the clause containing all of the districts is added to the query (1 click).

Vote Center Updates
The Vote Center is now updated several times a day instead of once a day.

Donation Form Responsive Layout
You can nowmake your donation forms available for display on tablets and smart phones as well as the
traditional web page on a personal computer. You must have an HTML 5 PageWrapper available for the
donation form.
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All donation form elements remain the same as in standard forms, except the Standard Donation Element and
the Payment Type Element, which have been updated for the Responsive layout.
The Standard Donation element in a Responsive layout does not include the column level layouts that can be
configured because they are not necessary in the Responsive layout.
The Payment Type element in a Responsive layout is more compact and uses selection buttons instead of
offering older-style drop-down menus for configuration, which were seldom used.
The Responsive option in the Form Layout is automatically available in Q1 2013.

Specifying Responsive as the Form Layout

When creating a new or editing an existing donation form in the Online Giving application, you can select the
Responsive option from the Form Layout drop-down on the Identify Form page.

Configuring the Responsive Standard Donation Level Element
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When configuring the Standard Donation Level element in a Responsive layout, you no longer set up the column
structure. The Responsive version has selection buttons laid out in a vertical column by default to accommodate
the smart phone layouts instead of arranging the selection buttons in columns as done in the Standard layouts.

Configuring the Responsive Payment Type Element

When configuring the Payment Type element in a Responsive layout, you just need to check the payment types
you want to display instead of going through all of the configuration options that were not used in the Standard
layout.

NEW FEATURES 5



The Help for these features will be available with the release of Q1 2013.

Events
This release introduces somemajor enhancements to Events. You can now group and report on event attendees
based on how they answer registration questions and customize the event registration form fields. In addition,
you can nowmakemultiple copies of an event at one time, reorder ticket types on the registration page, and,
finally, the layout of the registration page has been improved.

Add Any Constituent360 Field to Event Registration Forms
Previously, you could only add the First Name, Last Name, and Email fields to an event registration form - now
you can add any Constituent360 field. The registration fields are linked to Constituent360 so if the attendee is
new to your organization, a new Constituent360 record is made; if the registrant is an existing member, the fields
are automatically populated.

Note: The Constituent360 fields that are available vary depending on how your site is configured.

A new option and a new editing page have been added that allow you to add additional fields to the registration
form.
For more information, see the Customize the Event Registration Page video and the Luminate Online help.
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l New Option: Select a Template
You can now select either a Standard or a Custom template for an event registration form. If you select
the Standard template, no further action is required. If you select the Custom template, the next step is to
select the registration form fields. Click the Configure Constituent Registration Information editing page.

l New Editing Page: Configure Constituent Registration Information
If you select the Custom template, a new page in the editing process displays, Configure Constituent
Registration Information. Select the fields you want from the Available Fields column and move them to
theDisplayed Fields column. Within theDisplayed Fields column, you can configure individual fields to
be Editable, Read Only, or Required. You can drag the fields up and down to rearrange them and you can
also click theHeading button to add a heading above a field or group of fields. For example, you might
want to add the heading, Address, above the name, street address, and zip code fields.

Note: The First Name, Last Name, and Email fields are always required and cannot be removed from the
list.
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Group Attendees by Registration Question Answers
You can now group event attendees based on how they answer questions on the registration page. This can help
you to identify certain attendees that require further action. For example, you could ask attendees if they are
interested in volunteering for your organization and create a filter that groups those who reply “Yes”. This new
feature includes:

l A new editing page for defining group filters called , Create Group by Event Question.

l A new tab for managing filters called Event Groups.

l A new column in the Event Attendees report to list questions and responses by attendee.

For more information see the Create Groups Based on Event Question Responses video and the Luminate Online
help.

The New Create Group by Event Question Editing Page

When you click the Include Questions editing page, a new option, Create Group by Event Question, display at
the bottom of the left-hand column. This page allows you to define the filters for a group. Name the group and
select a question and the desired answer. You can add more than one filter to a group, but the attendees must
match all the criteria to be included. The filters are listed at the bottom of the page.
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The New Event Groups Tab

The new Event Groups tab is where you manage the filters for a single event (as opposed to all events). From this
tab you can view the attendees, view the filters that define the group, delete the group, change group security
settings, and so on.

The New Event Attendees Report Column

A new column has been added to the Event Attendees report in Report Writer called Survey Questions. This
adds a column for every event question and a row for every attendee and their answer to the report.
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Miscellaneous Enhancements
Some additional enhancements have also been made to the Events application including makemultiple copies,
reorder ticket types, and improved layout of the registration page.
For more information see the Events Enhancements video.

l Make multiple copies of events

You can nowmakemultiple copies of an event at one time instead of copying them one by one.

Note: This option is not available for Recurring, Multi-Day, or Multi-Part Events.

l Reorder Ticket Types (Coming in Q2)

Previously, ticket types only displayed on the registration page in order of price. You can now reorder the
ticket types any way you like, such as in alphabetical order. New grip bars in the ticket type rows in the
Configure Ticket Type editing page allow you to drag and rearrange the types.
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l Publish an Event, But Make it Private

Previously, when you published an event, it displayed on the Constituent-facing calendar. Now you have
the option to publish and event, but keep it private so that it does not display on the Constituent-facing
calendar. Only attendees who have been sent the URL can access the registration page.

l Improved Registration Page Layout

The layout of the registration page has been improved so that it is more pleasing and easier to locate
items.
The old registration page layout:
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The new registration page layout:

HTML5 PageWrappers
You can nowmake page wrappers with the HTML5 document type that make their associated pages (including
donation forms)more stylable with CSS and responsive to the layout of the device on which they are viewed,
such as smart phones and tablets.
The tableless designs allowed in HTML5 documents makes it much easier to customize your pages and style
them to your business standards using your own CSS to determine where content elements display on your
pages and what they look like. You can enter your custom div tags and style tags in CustomStyle.css provided in
PageWrapper Editor.
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After setting the HTML5 Document Type Declaration, you can add specific statements and CSS to make the page
wrapper and its associated pages responsive to the device layouts. This includes adding the statement to adjust
to the deviceand specific layouts for themobile devices you want to support.
The HTML5 Document Type Declaration option is automatically available in Q1 2013.
For more information, refer to the following:

l Declaring the Document Type

l Adding the Viewport Statement to Control the DeviceWidth Scaling

l Adding CSS Rules to Control Element Placement and Styling

l Adding theMobile Class Statement

l Adding HTML for the Elements that Display on the PageWrapper

For more information, view the HTML 5 PageWrapper video, or access the online help, click Help at the top of
any Page Wrapper Editor page in the Admin user interface.

Declaring the Document Type
When creating a new or editing an existing page wrapper in the PageWrapper Editor, you can select HTML5 as
the Document Type Declaration on theMeta Tags page.

Adding the Viewport Statement to Control Device Width Scaling
To allow pages associated with this page wrapper to scale automatically in response to the device on which they
are being viewed, you can add a viewport statement to the Head element in the Additional HTML Tags section:
<meta name="viewport" content="width=device-width, initial-scale=1.0,
maximum-scale=1.0;">
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Adding CSS Rules to Control Element Placement and Styling
To control the styling and element placement, you can also enter CSS rules in the Additional HTML Tags section in
a <style> section. For example, you can insert div tags to define the various sections, like the header, the links
typically found in the header or left navigation, and the login fields, and how the elements within the section
display. A sample snippet of code is provided in the PageWrapper Editor online help that you can use as a model
for this CSS.
You can define the screen widths and which elements to display or hide on tablet and smart phone devices by
inserting media statements in this Additional HTML Tags section. For example, you can code a snippet that hides
the login fields on a smart phone by entering display:none for the login-fields div in the Smart Phone Layout
definition.

Samples of this code are also contained within the sample snippet available from the PageWrapper Editor online
help.
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Adding the Mobile Class Statement
You should also enter a mobile class statement in the Body Tags section of the Body Tag Attributes page in Page
Wrapper Editor (for example, class="[[?xxtruex::x[[S80:mobile]]x::mobile::]]").

Adding HTML for the Elements that Display in the Page Wrapper
To style your header and content, you can enter the appropriate HTML on the HTML Body page. You can use S-
Tags to bring in content dynamically as well as link to other site pages and provide personalization on the pages.

Payment Capabilities
Site Administrators can use the new Luminate OnlinePayment Capabilities feature to import Blackbaud
Merchant Services (BBMS) accounts into Luminate Onlineand manage their organization's merchant accounts in
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Luminate Online.

Note: Contact your BlackbaudAccount Manager to assign access privileges to your organization's Site
Administrator.

A Payment Service (such as BBMS, PayPal, Amazon, or ACH) provides funds transfer capability from your
organization’s Luminate OnlineMerchant Account to the respective service provider.
AMerchant Account allows your organization to accept donations, recurring gifts, pledges, eCommerce, or event
ticket purchase transactions in Luminateand route them through the correct payment service. AMerchant
Account is comprised of one or more gateways to payment services.

Importing BlackbaudMerchant Services Accounts
An organization sets up their Blackbaud Payment Service (BBPS) account and associated Blackbaud Merchant
Services (BBMS) accounts outside of Luminate Online and then uses the Luminate Online Payment Capabilities
feature to import the BBMS accounts and associate them with a Luminate OnlineMerchant Account.
To import the externally defined BBMS gateways from your organization's BBPS account, navigate to Luminate
Online > Setup > Payment Capabilities.
For more information, see the Payment Capabilities video.

Click Import Blackbaud Merchant Services, log in to your BBPS account (not your BBMS account), and click
Import. The Payment Services page lists the imported BBMS accounts associated with the BBPS account that use
the currency supported on your site.

Note: If you make changes to the BBMS accounts outside of Luminate Online, you must reimport the changes
into Luminate Online.

Setting up aMerchant Account
To set up a Merchant Account, which is comprised of one or more Luminate gateways to payment services such
as BBMS or PayPal, navigate to Luminate Online > Setup > Payment Capabilities and click Create Account on
theMerchant Accounts tab.
For more information, see the Payment Capabilities video.
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Complete theMerchant Account setup on the Account Details and Merchant Detail pages.

Note: To add a BBMS gateway to your Luminate OnlineMerchant Account, select the BBMS credit card account
that you imported from BBPS.
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PDF Receipt Batching
A new recurring task is available to batch custom PDF receipts from a specific week into a ZIP file on the
exchange/common FTP site that you can download to store on-site at your place of business.
You must request that Convio Care or your Account Success Manager enable the Batch Receipts Recurring Task
in the Tasks list.

Note: Only custom PDF receipts are batched.

By default, this task runs every Monday through Sunday to batch up the new receipts or those that have been
modified. You can work with Convio Care to set a different time schedule with the PAYMENT_BATCH_RECEIPT_
TASK_DATE site option.
The ZIP file is accompanied by a CSV file that lists the details for each receipt in the batch, such as the name of the
constituent, the valued transaction, and date of the transaction.
If you lose a ZIP file or it is corrupted, you can request Convio Care to generate the ZIP file again as a one-time
task.

Queue Problem Management
Use the new Search feature on the Luminate Online Queue Problem Management tab to view the queue
synchronization error totals by type (that is, Contacts, Fundraising, Events, and Other). The Search page shows
the total error count and howmany errors originated in Luminate Online or Luminate CRM.
To use the Search feature, navigate to Luminate Online >Data Management > Luminate Management >Queue
Problem Management.

Click View to look at errors that occurred when data moved from Luminate Online to Luminate CRM or from
Luminate CRM to Luminate Online.
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Click the error category link to view all problems in the category.

Type a keyword in the Search box and click to find a particular type of error.
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Click an error link and then click Log to view themessage log.

Click the XML Message tab to view the XMLmessage contents.
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Click the Browse, Requeue All, Rebuild All, Delete All, or Export action buttons to requeue or deletemessages
or to export an error message report.
Refer to theManaging the Luminate Data Flow Luminate OnlineHelp topic for more information.

TeamRaiser
Several enhancements weremade to improve the participant experience as well as provide administrative
support for somemission-critical tasks.
Participants can register for a TeamRaiser event from their smart phones and tablets when the event is
configured with an HTML5 page wrapper, Responsive donation form, Responsive page layouts, and Donations2
Transaction Processing (an advanced event option). The Login information can be displayed earlier in the
registration flow to get to existing constituent information quickly, including the team they participated on in the
previous event if they are a returning participant.
Participants can also switch to another team, register as an individual after they are already registered with a
team, or join a team after they have registered as an individual using the new options in their Participant Center.
Event Administrators can:

l Easily add new questions, or modify existing ones, in their Blueprint TeamRaisers and push them down to
child events created from the Blueprint.

l Confirm gifts in batches using the Gifts Upload process to match the IDs of gifts that were recorded but are
in the Unconfirmed payment status.

l Update important constituent information in participant profiles using the Survey Question Response
Upload process instead ofmanually processing changes or additions to the responses on their registration
forms, which is useful for prize requests.

l Communicate with each other about a team by recording notes directly in the team records.

The Help for these new features will be available in Luminate Online Q1 2013.
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Blueprint Question Revisions
You can now add more questions to a Blueprint TeamRaiser and select to push the new question down to all
children TeamRaiser events that have been created from the Blueprint.
The Question Edit page has been updated to show the Question Type and Sort Order in a newQuestion Settings
area at the top of the page instead of displaying them as Steps 1 and 2without being able to edit them. The
Availability field now displays as Step 1 for you to make the question available to any child events that have
already been created from the Blueprint TeamRaiser.
When you add the new question, you can specify where to place it in the list of questions. If the local event
administrator has added questions, it is important to note that your question may be interleaved between their
local questions. Refer to the Blueprint TeamRaiser online help topic for details about sort ordering.
Note that even when you select to push the question to the child events, the pushed changes are scheduled to
run in a Push Changes background task (often scheduled for off-peak hours) and are not immediately available
until the task runs.
The newAvailability options and Settings panel are automatically available when the Blueprint Locking site option
is enabled on a site in Luminate Online Q1 2013.
Blueprint TeamRaiser questions lists are available for general event registration questions from the Related
Actions on the Select Event Options page, Team Captain questions from the Related Actions on the Select Team
Options page, and specific types of participation in the flow for editing or creating the Participation Type.
When creating a new question or editing an existing question from a Questions list, the Edit Question page
displays with the new Settings section at the top of the page and the Availability options as Step 1 of the edit
process.

Bring Back Team Prompt For Returning Participants
You can display a prompt to returning participants who are logged in that asks if they want to bring back their
team from the previous event to speed up their registration process.
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The Bring Back Team prompt is automatically available when the Returning Teams Advanced Event Options are
enabled and the TeamRaiser event is linked to a previous event in which the registrant participated on a site in
Luminate Online Q1 2013.
When the TeamRaiser event is linked with a previous event (on the Identify TeamRaiser page, to configure the
Returning Team Advanced Options:

1. From the TeamRaisers list, click Edit from the Actions column of the appropriate TeamRaiser event.

2. On the Identify TeamRaiser page, click Select Event Options.

3. From the Related Actions on the Select Event Options page, click Edit Advanced Event Options.

4. From the tasks along the left on the Define Advanced Fundraising Options page, click Define Returning
Teams Options.

5. On the Define Returning Teams Options page, click the Yes checkbox to display all of the appropriate
options.

6. For Forming a Team, click either Anyone option to allow returning participants to bring back the team
they participated on (or that they admired, if selecting the second Anyone option). Selecting to only let a
team captain bring back their team may be less effective if people have to wait to register until the captain
registers.

7. For Returning Teams Captain Role, optionally click the first option to let people come back to their team
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but not register as a captain.
8. When you are finished selecting these options, click Save.

Company Gifts Recorded as Unconfirmed or Confirmed
You can now enter gifts given to your event from local companies and mark the payment status as Unconfirmed
if you do not have the payment in hand or Confirmed if it has been received. You can also edit existing gifts to
enter the Payment Status.
The new Payment Status options on the Identify Gift page are available when the
COMPANY GIFTS CONFIRMABLE site option  is set to TRUE on a site in Luminate OnlineQ1 2013. Contact Client
Care or your Client Success Manager to enable this new option.
To work with company gifts:

1. From the TeamRaisers list, clickManage from the Actions column of the appropriate TeamRaiser event.

2. On the Find Participant page, click the Local Companies tab.

3. On the Local Companies list page, clickManage Company from the Actions column of the appropriate
company.
Click either:

l Add a New Gift from the Related Actions page and enter all the details, including selecting
Confirmed or Unconfirmed as the Payment Status.

l Edit from the Actions column of the appropriate gift and click the appropriate Payment Status
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option.

4. When you are finished selecting these options, click Save.

Gift Confirmation via Gift Uploads
You can now use a gift upload file process to change the Payment Status of gifts recorded in multiple donor
profiles from Unconfirmed to Confirmed when the payments have been received instead ofmanually performing
the process in each individual profile or creating new duplicate gift entries.
To change the payment status in the profile from Unconfirmed to Confirmed, the gift record in the upload file
must match an existing gift from the same donor for the same amount and date or the Gift ID.
The newGift Confirmation field is automatically available when Uploads are allowed on the site in Luminate
Online Q1 2013.
To work with this option:

1. From the TeamRaisers list page, click theUploads tab.

2. From the Related Actions on the Uploads page, click Gift Uploads.

3. On the Configure Parameters page, click the Yes checkbox for Gift Confirmation.
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Login Page at Front of the Registration Flow
You can nowmove the Login page for returning constituent to the front of the registration flow instead of
displaying it in the third step of the process. In addition to identifying your constituents and automatically
completing their information earlier, the need to place a Login component in the PageWrapper for mobile
devices, like smart phones, will no longer be necessary.
The Returning User Login Page Location option is automatically available in the Advanced Event Options in
Luminate Online Q1 2013.
When editing the configuration of a TeamRaiser event, to select this option:

1. From the TeamRaisers list, click Edit from the Actions column of the appropriate TeamRaiser event.

2. On the Identify TeamRaiser page, click Select Event Options.

3. From the Related Actions on the Select Event Options page, click Define Advanced Event Options.

4. From the tasks along the left of the Define Advanced Fundraising Options page, click Define Event
Options.

5. On the Advanced Event Options page, locate the Returning User Login Page Location task (near themiddle
of the page) and click First Step.
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Responsive Layouts for Greeting and Search Pages
You can now change the Layout for the TeamRaiser Greeting and Search pages to make them responsive to the
device on which they are being viewed. This completes the work to make TeamRaiser event registration pages
available on a tablet or smart phone. For more information, see the Optimize TeamRaiser Registration for Mobile
Devices video.
The Responsive option in the Layout drop-down menu when configuring these pages is available automatically in
Luminate Online Q1 2013.

Configuring the Responsive Layout for the Greeting Page
The Responsive layout for the Greeting page enables you to customize and style your page. The default Greeting
page has been updated and provides certain component arrangements that may display only on the larger
device layouts, like your typicalWeb page on your personal computer or a tablet (shown below).
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For example, you can specify to hide the Login component on a smart phone.
To configure the Greeting page with the Responsive layout:

1. From the TeamRaisers list, click Edit from the Actions column of the appropriate TeamRaiser event.

2. From the tasks along the left of the Identify TeamRaiser Details page, click Customize Pages.

3. In the TeamRaisers pages list, click Configure from the Actions column of the Greeting Page.

4. On the edit page, click Responsive from the Layout drop-down and then click Finish (at the bottom of the
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page).

5. Back on the TeamRaiser Pages list, click Configure from the Actions column of the Find Participant page
and repeat the step above.

Configuring the Responsive Layout for the Search Pages
The Search pages for locating a participant or a team have been updated when in the Responsive layout.
Enhanced for a moremodern look, the default Participant Search displays with two simple fields.
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Clicking theMagnifying Glass icon expands the fields available for a participant search.
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You can click the Team tab to search for a specific team.

And you can expand the Team search options by clicking theMagnifying Glass icon.

To configure the search pages with the Responsive layout:
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1. From the TeamRaisers list, click Edit from the Actions column of the appropriate TeamRaiser event.

2. From the tasks along the left of the Identify TeamRaiser Details page, click Customize Pages.

3. In the TeamRaisers pages list, click Configure from the Actions column of the Find Participant Page.

4. On the edit page, click Responsive from the Layout drop-down and then click Finish (at the bottom of the
page).

Configuring a Responsive TeamRaiser Registration Layout
You can now provide a TeamRaiser registration process that enables your participants to register for a
TeamRaiser event on their personal computer, tablet, or smart phone.
You must:

l Create an HTML 5 Page Wrapper (or convert an existing one to use the HTML 5.0 document declaration)
and apply appropriatemobile device statements and CSS. For details, refer to the section in this
document about HTML 5 PageWrappers, PageWrappor access the product online help topic by clicking
the Help link at the top of a PageWrapper Editor page.

l Create a donation form that uses the Responsive layout (or convert an existing one). For details, refer to
section in this document about Responsive Donation Forms. (The product online help topic will be
available when Luminate Online Q1 2013 is released.)

l Configure the following TeamRaiser pages to use the Responsive layout:
l Greeting

l Find a Participant

l Team Selection

l Team Password

l Participation Options

l Returning Participant Login

l Registration Information

l Secondary Registration Information

l Waiver

l Registration Summary

l Thank You

Participant Information Updates via Response Uploads
You can now update participant profiles with new values for question responses asked on the registration pages
of a TeamRaiser event using an upload file. The value in the upload file will replace the existing value in the profile
or fill in the field if it is blank. If the response column is left blank in the upload file but a value exists in the profile,
the profile value will be replaced with the blank.
The OverwriteMode option is automatically available when Uploads are allowed on a site in Luminate Online Q1
2013.
To work with the OverwriteMode option:
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1. From the TeamRaisers list page, click theUploads tab.

2. From the Related Actions on the Uploads page, click Upload Survey Responses.

3. On the Configure Parameters page, click the Yes checkbox forOverwrite Mode and then click Next.

TeamNotes
To help facilitate communication between your event administrators about teams participating in a TeamRaiser
event, you can enter notes about the team on their Team record for other event administrators to read. A Note
icon displays next to a team that has notes recorded in the list of teams. The notes about a team can also be
printed.
The Team Notes feature is automatically available on the Team Record in Luminate Online Q1 2013.
You can:

l Create a team note on the record of a specific team

l Identify a team with notes from the Teams list

l Read the notes about a team

l Print out the notes about a team

Creating a Team Note

} To create a note on the record of a specific team:

1. From the TeamRaisers list, clickManage from the Actions column of the TeamRaiser event.

2. On the Find Participant page, click the Teams tab.

3. On the Teams list page, clickManage from the Actions column of the appropriate team.

4. On the Team Details page, click theNotes tab.
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5. From the Related Actions on the Notes page, click Create a Team Note.
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6. On the Notes edit page:

a. Enter a Subject to display in the Notes list to identify the reason or purpose of the note.

b. Select the Security Category of the appropriate administrators allowed to view, edit, and print this
note.

c. In the Text area, enter the content of the note.

d. When you are done, click Finish.

Identifying a Team With Notes
When notes have been recorded about a team, the Notes icon displays in the Teams list to the right of the team
name. You can click the icon to display the list of Notes available for the team.

Reading Notes About a Team

} To display the notes about a team:

1. From the TeamRaisers list, clickManage from the Actions column of the TeamRaiser event.

2. On the Find Participant page, click the Teams tab.

3. On the Teams list page, clickManage Team from the Actions column of the appropriate team.

4. On the Team Details page, click theNotes tab.

5. In the Notes list, click View/Edit from the Actions column of the appropriate note.
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Printing the Notes About a Team

} To print the notes about this team:

1. From the TeamRaisers list, clickManage from the Actions column of the TeamRaiser event.

2. On the Find Participant page, click the Teams tab.

3. On the Teams list page, clickManage from the Actions column of the appropriate team.

4. On the Team Details page, click theNotes tab.

5. From the Related Actions on the Notes list page, click Print the Notes.

6. When the note page opens in a separate browser window, follow the normal print process in your envir-
onment to print the page of notes displayed.
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Self-Service PC2 TeamOptions
Previously, if a Participant wanted to change their team or re-register as an individual, they had to call the
organization's support line and ask someone to change it. In order to reduce the amount of calls to support, new
self-service options in the Participant Center that allow Participant's to:

l Switch to another team

l Register as an individual after they are already registered with a team

l Register with a team after they are already registered as an individual

Gifts follow the Participant wherever they go, if they change teams, join a team, or leave a team and become an
individual Participant.

} To access the self-service options

1. Login to the Participant Center.

2. Click Change Team Membership.
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3. Select either Join a team,

4. Or Participate as an individual.
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} To enable the self-service options

1. Click Fundraising > TeamRaiser.

2. Click Edit in the Action column for the correct event.

3. Click Event Options > Edit Advanced Options > Define Event Options.

4. Scroll down to item 9, Participant Team Self Management and select the option.
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